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Figures

The instructions on this page pertain to figures included in the main article.

Figure Preparation Checklist

Figure File Requirements
The list below is an abbreviated summary of the figure specifications. Read the full details of the
requirements in the corresponding sections on this page.

File Format TIFF or EPS

Dimensions Width: 789 – 2250 pixels (at 300 dpi). Height maximum: 2625 pixels (at 300 dpi).

Resolution 300 – 600 dpi

File Size <10 MB

Text within Figures Arial, Times, or Symbol font only in 8-12 point

Figure Files Fig1.tif, Fig2.eps, and so on. Match file name to caption label and citation.

Captions In the manuscript, not in the figure file.

Before we can formally accept your submission, your figures must meet the requirements on this page.
The more closely your figures adhere to these specifications at full submission, the fewer times you will need to revise
your manuscript to meet the requirements. Your figures will therefore be less likely to slow down publication of your
accepted manuscript.



Figures as Supporting Information

Supporting information is auxiliary to the main content of the article. Supporting information figures are held to the
requirements of all supporting information files. They have fewer requirements than figures that are included in the main
article, and they need to be uploaded separately.

For full instructions, follow the supporting information guidelines.



Read our figure policies on depictions of humans, licenses and copyright, and image manipulation.

Read our figure preparation guidelines, and our requirements for reporting blot and gel data (as relevant).

Read the figure file requirements for the full list of technical specifications, and ensure your figures comply.

Read how to format and submit your figures and captions for peer review.

Use NAAS before submitting to check your figures and convert to our accepted formats.
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File Format  

TIFF or EPS only.

Should I choose TIFF or EPS? TIFF tends to be easier to work with than EPS. EPS files often
have missing/corrupted fonts, oversized masks, stray points, and boxes, which can result in
errors and poor output. 

Dimensions   Centimeters Inches Pixels at 300
dpi

Minimum width 6.68 2.63 789

Maximum width 19.05 7.5 2250

Height maximum 

At the height maximum, the figure occupies the
whole page and excludes the caption

22.23 8.75 2625

“Dimensions” refers to the dimensions of the entire figure, excluding any white space. The closer figures
match these dimensions, the closer they will meet expectations on publication.

TIPS

To align your figure with the text column of the PDF version of the article, make it no wider than
5.2 inches (13.2 cm). 



Ensure that individual images meet the pixel dimensions indicated above when preparing and
saving figures with slideshow software (like Powerpoint, OpenOffice, or Keynote).



Make sure source images are 2,250 pixels wide if you want figures at full page width of 19.05cm.

When adjusting the figure dimensions, be sure the Chain/Lock symbol is closed. This will
maintain the width and height ratio of your figure.



Go to Image → Properties (or Image → Information) to view image dimensions.
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Resolution  

Submit figures at the desired dimensions with a resolution no greater than 300-600 dpi. 

File Size  

Submit files at a size of 10 MB or less. Use the NAAS tool for help resizing. If you elect not to use NAAS,
follow the instructions below to manually resize TIFF or EPS files.

Reducing TIFF file size

Reducing EPS file size

Text within
Figures

 

Use only Arial, Times, or Symbol font in 8-12 point.​ 

Do not include author names, article title, or figure number/title/caption within figure files. That
information will go into your figure caption in the manuscript. Read more about submitting captions.

Multi-panel
Figures

 

Place all panels from a multi-part figure into a single page and single file:

1. Combine multiple panels into one page, or break them apart into separate figures.

2. Renumber all figures and in-text citations accordingly.

The quality of a low-resolution figure cannot be improved by simply increasing the resolution in
graphics software. To improve its resolution, re-create the figure from the beginning.



Resolution below 300 results in blurred, jagged or pixelated published figures. ​Resolution above
600 dpi may lead to resizing of the published figure.



The quality of your figures is only as good as the lowest-resolution element present. If you
created a 72 dpi line graph and placed it in a 300 dpi TIFF, the graph will look blurred, jagged, or
pixilated.



Save with LZW compression.

Set resolution between 300-600 dpi.

Flatten. A flattened TIFF has a single layer called “background” and has a smaller file size than a
TIFF with “Layer 1”.



Source images created in EPS format need to be compressed (in your compression format of
choice) and should be no larger than full page size.



If your EPS files are still too large, convert them to PDF and then export to a compressed TIFF.

Text within EPS figures

Embed fonts, or convert them to outlines to prevent missing or improperly rendered text. In
those files that are created in software like Matlab, open Illustrator or Inkscape and convert
text to outlines. You will not be able to change your text after it has been converted to
outlines.

Instructions for Illustrator

1. Select all (Ctrl + A)
2. Shift + Control + O on PC (Shift + Command + O on Mac)

Instructions for Inkscape

1. Select all (Ctrl + A)
2. ​Shift + Ctrl + C



To create a multi-panel figure from individual files, use a presentation program such as OpenOffice
Impress, Microsoft PowerPoint, or Keynote for Mac. Then convert to TIFF.


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Color Mode  

RGB (8 bit/channel) or grayscale only.

White Space  

A 2-point white space border around each figure is recommended to prevent inadvertent cropping of
content at layout. Crop out excess white space around image content.

Orientation  

Rotate and submit the figure in the orientation that you wish it to publish.

Additional Requirements for TIFF 

Layers  

Flattened, with no layers. Figures with a single layer named “layer 1” or “layer 0” are in fact layered.

Alpha
Channels

 

No alpha channels.

Compression  

LZW compression is required. To apply: 

Pages  

We cannot publish TIFF figures that span multiple pages. To combine multiple figures onto a single
page, see Multi-panel Figures.

How to Submit Figures and Captions
Your figures contain three elements: figure files, captions, and in-text citations.

When naming your figures, match the figure file name and the caption label with the corresponding in-text
citations in the manuscript. Example: a figure file named “Fig1.tif” should match the citation “Fig 1” and the
figure label “Fig 1.” in the caption.

To set up the page, use the values listed in Dimensions.

Use an Insert tool to place figures. Do not drag/drop or copy/paste images into the file, because
this results in a 72 dpi image.



If your figures have numerous pictures, charts, or small text, they will render best at a resolution
of 600 dpi.



Figures will be inserted into the typeset article in the orientation in which they are supplied.
For example, if a vertical image is submitted in a horizontal orientation, it will be set
horizontally in the article.



In GIMP, use “Export” instead of “Save As”. Select TIFF as the format, and then select LZW
compression.



In Photoshop, select “LZW compression” and “Discard Layers, and Save a Copy.”
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 

Figure
files

Initial & full submissions

You can choose to format your submission as either:

Revised submissions

Captions  

Label. Name figure labels using Arabic numerals, and abbreviate the word “Figure” to “Fig” (e.g.,
Fig 1, Fig 2, Fig 3, etc.).

Title. The title should be concise and descriptive. Restrict it to 15 words or less. 

Legend. Place the legend directly after the title of the figure to which it belongs. Place any figure
credits in the last sentence of the legend. 

Caption credit: Means JC, Venkatesan A, Gerdes B, Fan J-Y, Bjes ES, Price JL (2015) Drosophila Spaghetti and
Doubletime Link the Circadian Clock and Light to Caspases, Apoptosis and Tauopathy. PLoS Genet 11(5):
e1005171. https://doi.org/10.1371/journal.pgen.1005171

In-text
citations

 

​A single PDF containing the manuscript, figures, and supporting information, or

A PDF or Word document manuscript, with figures and supporting information uploaded individually

Name files in numeric order with the format: Fig1.tif, Fig2.eps, and so on. 

Upload each figure as an individual file that is separate from the manuscript.

If at any point you change the numbering order of your figures, be sure to update all figure citations,
captions, and file names accordingly.



Place each caption in the manuscript text in read order, immediately following the paragraph where the
figure is first cited. Do not include captions as part of the figure files or submit them in a separate document.



Format your figure captions. There are two required elements: figure label and figure title. Legends are
optional.



Figure legends tips

Be succinct: Avoid lengthy descriptions of methods. 

Describe the key messages of a figure: provide a description of the figure that will allow readers to
understand it without referring to the text.



Describe each part of a multipart figure with with a lettered panel label: for example, (A) or (a).

Define all non-standard symbols and abbreviations.​

Cite figures with the format: Fig 1A, Fig 1B, Fig 2, Fig 3, etc.

Cite figures in ascending numeric order upon first appearance in the manuscript file. This includes citations
to text boxes and tables. In the published article, figures are inserted according to the placement of their first
citation and caption in the article.


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Tools for Figure Preparation

Automated figure assessment

PLOS provides a free, simple-to-use tool called NAAS to help you review and prepare your figures for
submission and achieve high publication quality figure presentation.

NAAS will assess whether your figures meet our technical requirements by comparing each figure against
our figure specifications (see Figure File Requirements). The tool can also resize and convert figures to
TIFF format. In cases where NAAS cannot process your figure file, the tool will provide you with a report of
what it could not fix. Please note that figures must be captured between 300 and 600 dpi in order for NAAS
to successfully process your figures.

NOTE: Supporting Information figures should not be processed through NAAS.

Please review your figures after NAAS’s assessment to ensure that they adhere to journal figure guidelines
and that they are not blurry or difficult to read.

Go to NAAS now.

Software

If you prefer to assemble figures with vector graphics, we recommend that you use Adobe Illustrator or
Inkscape (free). These figures must be exported to EPS format per our requirements.

If you prefer to use raster graphics, the following free programs can both manipulate and export TIFF files:

LaTeX
PLOS does not accept vector EPS figures generated in LaTeX. Submit TIFF or EPS figures created in
standard software. Read about other software options.

Converting LaTeX-generated EPS figures to TIFF

1. Compile the LaTeX files into a PDF.

2. Open the PDF in Photoshop, GIMP, or another graphics program that enables TIFF.

3. Crop out the figure and export as TIFF.

Creating Source Images with Specialized Software

While we cannot offer assistance using the software in this section, the instructions below indicate the proper settings for
creating specialized scientific images that meet our figure requirements.

SigmaPlot

Creating a PLOS compatible graph

1. First create your graph, and save it in SigmaPlot format.

2. From the Tools menu select Options. In the dialogue box that appears, click on the Page tab. Set the Units to Millimeters (mm)
and make sure the Graph Objects → Resize with Graph option is not ticked. Click OK.

3. From the file menu select Page Setup. In the dialogue box that appears, click on the Margins tab. Set all the margins to 0.0 mm,
then click Apply.

4. Now click on the Page Size tab. Set the Width to 190.5 mm (or 132.0 mm for text column width) and the Height to 222.3 mm.
Click OK.

5. Set the font size of all text to 8 pt, and the width of all lines to 0.2 mm. (Consult the SigmaPlot Help files for more details, if
needed.)

Lettered subparts of whole figures may be cited in any order in the text if the first mention of each whole
figure is in numerical order. For example, you can cite any subpart of Fig 3 in any order (e.g., Fig 3C before
Fig 3A), as long as Figs 1 and 2 have already been cited.



Although our staff can offer guidance and advice, PLOS does not provide graphics services. Preparation and final
quality of figures is the responsibility of the author.



GIMP

Open Office
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6. Resize your graph to fit within and make full use of the page width available.

Saving an image in PDF format

This is the preferred output format when using SigmaPlot. To make sure your image is saved in a
compatible format, perform the following steps.

1. From the File menu in SigmaPlot, select Print. In the Print dialogue box that appears, select Adobe PDF as the printer. Click on
Properties.

2. Change the Default Settings pull-down to Press Quality. Uncheck the View Adobe PDF results box if you don't want Acrobat to
launch.

3. Click OK, then click OK. Pick where the PDF will be created, and click Save.

4. Lastly, open the PDF in one of the following three programs to save the file in TIFF format: NAAS, Photoshop, or GIMP.
RStudio

Export figures from RStudio in EPS format. If you prefer to submit a TIFF file, use NAAS to do the
conversion and achieve a resolution of 300dpi. TIFF files exported directly from RStudio will only achieve a
resolution of 72dpi.

 

The table below provides the export settings and instructions for authors that choose to create TIFF source
images with the software indicated.

Image format: EPS

Width: 789 pixels at minimum

Check “Maintain aspect ratio”

Submit in EPS format, or use NAAS to convert to TIFF
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Software Settings and Instructions

Matlab Knowing the target size of your image in inches and dpi, first convert the number of rows and columns in the
image. 4.86 inches by 9.19 inches (a 1.5 column figure at maximum height) at 300 dpi corresponds to 1458 pixels
by 2757 pixels. Modify your image to be 1485 by 2757. (Resize it, crop it, compute it differently, etc.) Then save
your 1458 by 2757 image as a TIFF file, specifying 300 as the resolution.

imwrite(my_image, ‘figure_10.tif’, ‘Resolution’, 300);

function write Fig 300 dpi (figNo, fileName)
%make the background white
Set(figNo,’color’,’w’;
f=getframe(figNo);
colormap(f.colormap)
imwrite(f.cdata, fileName,’ Resolution’, 300;

Prism Export your graph with the following settings:

File format: TIFF
Resolution: 300
Color Mode: RGB
Size Make Width: 7.5 in
Enable Compression

Stata Stata does everything at screen resolution (72 dpi). If you want to have a panel that is half page width, export the
image at 39.52 cm. For full page width, export at 79.25 cm.

ChemDraw Export to SVG (Windows Version only). The SVG format, like a PDF or EPS, is a vector based graphic format.
GIMP and Photoshop will treat it in the same way as they would a PDF. Use Photoshop or GIMP to edit your
figure.

PyMol To get a 300 dpi PNG file for a 4.92 inch by 9.25 inch image, use the following settings.

Ray-traced:
Ray 1458,2757
Pnghires_ray.pdb, dpi=300

OpenGL:
Draw 1458,2757
Pnghires_ogl.pdb, dpi=300

SPSS Export a PDF, then bring that PDF into Photoshop or GIMP.

GeneSpring Export as Image.
Unit: cm.
Print Width: 19.05, Lock Aspect Ratio, Image Resolution (in dpi): 600.

Minitab “Save Graph As” with the following settings:

Save as Type: TIF
Color: RGB
Custom Resolution: 600

Maps
PLOS applies the Creative Commons Attribution (CC BY) license to all the works we publish. Read about
our licenses and copyright policy for figures.

When creating a figure that includes a map, be sure to check the usage rights. Several sites provide maps
that are compatible with CC BY licensing, including:

USGS: all USGS maps are in the public domain

SEDAC: many maps from SEDAC are available under an Open Access license

World of Maps: may include maps in the public domain
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PLOS neither endorses nor takes responsibility for the maps or geodata from the above sites.
Policies
All figures must comply with PLOS policies covering depictions of humans, and licenses and copyright.

Depictions of humans

Authors submitting manuscripts that include identifying or potentially identifying information must comply
with our requirements for informed consent.

Identifying information includes, but is not limited to:

Read our guidelines for documenting informed consent. If you require further information, please contact
the journal before submitting.

Licenses and copyright

Figures, tables, and images are published under the Creative Commons Attribution (CC BY) license.

Image manipulation
Image files should not be manipulated or adjusted in any way that could lead to misinterpretation of the
information present in the original image. We routinely check figures for all accepted articles. Please be
aware that we may also require you to supply us with your original photographic images in the original file
format and at the resolution at which they were first created.

Avoiding image manipulation

We realize that the extent to which figures can be changed as part of normal preparation can pose a
dilemma. Please refer to the general guidance below on aspects to consider when preparing your figures.

OpenStreetMap: OpenStreetMap map tiles are free to use as long as they are accompanied by the following attribution
statement: “Base map and data from OpenStreetMap and OpenStreetMap Foundation”. Maps created using OpenStreetMap
data must be accompanied by the following attribution statement: "Contains information from OpenStreetMap and
OpenStreetMap Foundation, which is made available under the Open Database License.”



A map that is free to download may be restricted in other ways. Do not use Google, Mapquest, or other copyrighted
maps.



photographs

radiographs

pedigrees (family trees)

geospatial maps that can identify a specific location such as a house.

Do not submit any figures, photos, tables, or other works that have been previously copyrighted or that contain
proprietary data unless you have and can supply written permission from the copyright holder to use that content.

This includes:

Read the full licenses and copyright policy.​

maps and satellite images

slogans and logos

social media content.



For further information, image examples, and more detailed guidance we advise reading What’s in a picture? The
temptation of image manipulation (reprinted in the Journal of Cell Biology, 2004;166(1):11-15).

We are grateful to staff at the Journal of Cell Biology (Rockefeller University Press) for their help in establishing these
guidelines and procedures.


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Common issues to avoid

The following examples are all considered to be unacceptable image manipulation:

EXAMPLES: See Figures 1 and 5 of What’s in a picture? The temptation of image manipulation.

EXAMPLE: See Figure 6 of What’s in a picture? The temptation of image manipulation.

EXAMPLE: See Figure 3 of What’s in a picture? The temptation of image manipulation.

Creating high-quality images

Poor-quality images may raise figure manipulation queries and/or result in requests to remake figures.
Follow these tips for creating high-quality images:

EXAMPLE: See Figure 4 of What’s in a picture? The temptation of image manipulation.

Contact
If you still have questions about how to prepare your figures, please contact figures@plos.org for
assistance.

The introduction, enhancement, movement, or removal of specific feature(s) within an image

Unmarked grouping of images that should otherwise have been presented separately (for example, from different parts of the
same gel, or from different gels, fields, or exposures)



Adjustments of brightness, contrast, or color balance that obscure, eliminate, or misrepresent any information

Ensure that your images have a resolution of at least 300 pixels per inch (ppi) and appear sharp, not pixelated. Poor-quality
images cannot be checked.



Be careful not to inadvertently reduce the resolution when creating a file in graphics editing software

When opening your image file in graphics editing software, you have the option of setting the size and resolution of the
image. Do not set the total number of pixels to be greater than that in the original image (e.g., from the digital
camera attached to your microscope) while keeping the image size the same; otherwise, the computer must create
data for you that were not present in the original, and the resulting image is a misrepresentation of the original data. The
resolution (ppi) can be increased only if the image size is reduced proportionately.



Spliced gels need a thin dividing line added to indicate the alteration. It is fine to remove a complete lane and splice the
remaining lanes together, but the alteration must be indicated by a thin white or black line between the juxtaposed pieces.



Images must contain the background “noise” they originally contained. The background should not appear as one uniform
color. Do not “clean up” the background of images with rubberstamp or “wipe” tools to improve the aesthetic appearance, or
over-adjust the brightness or contrast so that the background is removed.


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